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Introduction 

 

The focus of the 2017.01 release is on addressing the legislative changes that take 
effect from 1 April 2017. It also adds new features to the Exo Employer Services system, 
including the ability to create test companies, and includes enhancements to existing 
features, such as updates to the Employee List and Pay List windows. 

(This release can be installed prior to 1 April 2017; compliance changes are not 
activated in the product until the relevant date, e.g. changes to tax codes are applied 
when a pay ending on or after 1 April 2017 is run.) 

The purpose of this document is to provide essential information on the installation 
and use of this release: 

 The Installation section provides an overview of the installation process, 
including pre-installation requirements and post installation steps. 

 The New Features section describes all new features introduced in this release. 

 The Resolved Issues section describes all issues that have been addressed by 
this release. 

 The Known Issues section details any issues in this release that have been 
identified as requiring attention. 

Need assistance? If you have any questions or you need assistance with installing this 
update, contact MYOB Exo Support from 8:30AM to 5.00PM, Monday to Friday on 
0800 MYOB Exo (0800 696 239) or via e-mail at anzpayrollsupport@myob.com. 

 

mailto:anzpayrollsupport@myob.com
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Installation 

Pre-Install Requirements 

Requirements for PCs running Exo Employer Services components are detailed in the 
Minimum System Requirements document, available on the MYOB website. 

Installing Exo Employer Services 

Information on installing and upgrading MYOB Exo Employer Services is maintained 
on the MYOB Enterprise Knowledgebase. See the following articles: 

 Upgrading MYOB Exo Employer Services Online 

 Upgrading MYOB Exo Employer Services Manually (New Zealand) 

 How do I run Network.exe? 

Note:  Check the Known Issues section on page 27 for any known installation 
issues. 

Post-Installation 

After the installation is complete, the version numbers of all MYOB Exo Employer 
Services applications should be as follows: 

Application Version 

MYOB Exo Employer Services 2017.01 

MYOB Exo Payroll (NZ) 2017.01 

MYOB Exo Health and Safety 2017.01 

MYOB Exo Employee Information 2017.01 

MYOB Exo Time and Attendance 2017.01 

Runtime Files 09.00.0000.7423 

To ensure that this release installed successfully, check that the versions displayed on 
the About window (Help menu > About) match the versions listed here. 

http://myob.co.nz/products/medium-business/enterprise-solutions/exo-employer-services-1257828259186?productArea=System+Requirements&category=1257828963014
http://myobexo.custhelp.com/app/answers/detail/a_id/34710
http://myobexo.custhelp.com/app/answers/detail/a_id/32763
http://myobexo.custhelp.com/app/answers/detail/a_id/33027
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New Features 

Important Upgrade Notice 

This release includes a new version of the MYOB PDF Converter, which is compatible 
e 0x8007007e: The 

 when generating PDFs on Windows 10, this 
version will correct the error. Installing Exo Employer Services locally will update the 
MYOB PDF Converter on the local PC you must run Network.exe to reinstall the 
converter on all networked PCs. 

Tax Updates 

The compliance changes and features introduced in Exo Employer Services 2017.01 are 
listed below. 

ACC Rates and Thresholds 

Changes to ACC come into effect on 1 April 2017. MYOB Exo Payroll has been updated 
to incorporate the following changes: 

Detail Current Value New Value 

ACC earner levy rate 1.39% 1.39% 

ACC income maximum $122,063.00 $124,053.00 

Maximum ACC earner levy $1,696.67 $1,724.33 

These changes affect all tax code calculations. 

Changes to the WT Tax Code 

Rules around schedular payment rules, for which the WT tax code is usually used, are 
changing as of 1 April 2017: 

 Contractors (including companies) hired by labour-hire firms under a labour-
hire arrangement will be added as a new schedular payment type. 

 Another new schedular payment type for persons wanting to voluntarily have 
tax deducted from their contractor income will be added. Voluntary schedular 
payments have a standard rate of 20%. 

 Most contractors will have the ability to set their own withholding rate, subject 
to a minimum of 10%. (If the contractor provides their name and IRD number 
but does not choose a rate, the standard rate for the type of payment is to be 
used.) 

 T -notification , i.e. the rate for contractors who have not supplied 
their own withholding rate, is changing to 45%. 

We recommend that you review the tax rates entered for all employee records with 
the WT tax code. 
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The IRD has also advised that contractors on the WT tax code should not have 
KiwiSaver payments deducted from their pay or included in the Employer Monthly 
Schedule (IR348). This release includes updates to Exo Payroll to address this: 

 If a new employee is created and given the WT tax code, KiwiSaver deductions 
will be turned off for that employee by default. 

 Any time Exo Payroll detects an employee on the WT tax code who also has 
KiwiSaver payments set up, e.g. when configuring  KiwiSaver 
details or when creating pays, it will automatically remove the KiwiSaver 
payments 
what has been done. 

Student Loan Thresholds 

This release updates the student loan thresholds for the 2017-2018 financial year. The 
new thresholds are: 

Period Value 

Annual $19,136.00 

Monthly $1,594.66 

4-weekly $1,472.00 

Fortnightly $736.00 

Weekly $368.00 
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Updates to List Views 

Holiday Pay List 

A new Holiday Pay list window is available to provide easy access to Holiday Pay 
information for all employees in the system. Open the Holiday Pay window by 
selecting Report Views > Holiday Pay from the Reports menu. 

Note:  Access to the Holiday Pay window is controlled by the Report  Holiday pay 
option on the Access Rights tab of the User Security window. The Report 
Views option also contains links to the Employee List and Pay List windows 
(if the user has access rights to view them). 

 

Use the dropdowns at the top of the window to filter the list. Click Clear Filters to reset 

all dropdowns to their defaults. The Show/Hide Column button (  ) lets you choose 
which list columns to display and which to hide. 

Double-click on an employee, or select them and click the View Employee button at 
the bottom of the window, to open the Employee Maintenance window for that 
employee. 

Click the Copy button to copy the contents of the list to the clipboard. If Microsoft 
Excel is installed, this button is replaced with an Export button, which exports the 
contents of the list to an Excel file in the .XLSX format. 
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Resetting Pays 

n open pay from the 
Pay List window. A Reset All button has been added to the Pay Details window that 
opens when a pay has been selected: 

 

Clicking the Reset All button lets you clear or reset the pays of all listed employees (i.e. 
only those employees who match the current filter settings will be affected, which may 
not be all employees in the pay). You are asked to confirm the operation, and then 
select the operation to apply to the employees: 

 

Note:  While the Reset All button resets the pays of all employees in the list, the 
Reset Pay right-click menu option lets you reset the pay of the individual 
employee who was right-clicked on. 

Note:  This release introduces changes designed to avoid accidentally clearing an 
he default option is now to reset the pay to the 

 
selected, a warning message now appears before the pay can be cleared. 
This applies when resetting pays from the Pay List and when resetting them 
from a Current or One-Off Pay. 
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Custom Views 

The Employee List, Pay Details and Holiday Pay list windows all feature a new Custom 
Views section, which lets you save the current filtering settings and column layout as a 
reusable view. Custom views can be private, i.e. only available to the logged in user, or 
public, which means once saved they are available for all users. 

 

The Custom Views section includes the following controls: 

 Dropdown of all available views 

 Create View button 

 Save View button 

 Load View button 

 Auto-size Columns button 

 Show/Hide Columns button 

New List Columns 

New columns are available on the Employee List, giving access to a wide variety of 
employee properties, including a new Time and Attendance column, which is available 

indicate if employees have been added to the Exo Time and Attendance system. 

New columns have also been added to Pay Details window that opens from the Pay 
List. In both cases, the new columns are not displayed by default; they can be selected 
by clicking the Show/Hide Columns button (see above): 
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Pay List Default Filtering 

The Pay List now shows only pays from the last 12 months when it is first opened this 
ensures that the window will not take a long time to open when there are a large 
number of pays in the system. Once the window is open, you can use the date filters 
to show pays that are more than 12 months old if you want to. 

Historical Records 

Previous releases added the ability to mark certain records as historical. This release 
expands these features across multiple Exo Employer Services products. 

Departments 

Department records can now be marked as historical in Exo Payroll and Exo Time and 
Attendance.  

 

Ticking the Historical Department option marks the record as historical, which means 
that it will no longer appear on Department lookup windows, so that users can avoid 
having to scroll through long lists of obsolete records. When selecting Departments to 
appear on reports, an option to show or hide historical records is available. 

Note:  As with other historical records, you cannot mark a record as historical if it is 
currently in use, e.g. assigned to an employee record or included an 

-Off or Standard Pay. 

Cost Centres in Exo Time and Attendance 

Exo Time and Attendance now recognises when Cost Centres have been marked as 
historical in Exo Payroll. Historical Cost Centres are hidden by default on lookup 
windows, so that users can avoid having to scroll through long lists of obsolete Cost 
Centres. 

Reporting Changes 

The Maintenance reports for Deductions, Allowances, Cost Centres and Departments 
all now include a new Historical 
whether or not the record has been marked as historical. 
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Employee Maintenance Update 

Edit buttons have been added to the Cost Centre and Department fields on the 
Employee Details tab of the Employee Maintenance window, making it easier to select 
a Cost Centre and Department for an employee: 

 

Report Updates 

Updates to the Custom Payslip 

The Payslip Summary Report section of the Custom Payslip (which is printed when the 
Print Summary Slip report option is ticked) now displays ESCT amounts. The summary 
is now organised into sections, and displays total amounts more prominently: 
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To improve readability, some values in the lower section of Custom Payslips have been 
reorganised and balances are displayed in boldface: 

 

Note:  If you have made changes to the existing A4 and/or A5 templates, you will 
need to reset them and re-apply your customisations to enable the new 
features introduced in this release. 

Exporting to Excel 

format: 

 

Note:  
option will not be available. 
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When exporting to Excel, you can choose and order the columns to be exported in the 
same way that you can when exporting to a CSV file: 

 

New Pay Sheet Option 

A new option has been added to the Pay Sheet report, allowing it to be printed by 
Physical Pay Date, as well as Pay Period End Date: 
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New Paid Parental Leave Option 

The selection ranges for the Paid Parental Leave report have been updated: 

 

Test Companies 

This release adds the ability to set up one test company for each company in the Exo 
Employer Services system. Test companies have restricted functionality, but do not 
count towards your licensing limits, so you can use them to test out configuration 
changes without affecting the original company. 

To create a test company, log in to a company and select the New Test Company 
option from the File menu of Exo Payroll: 

 

If a test company has already been created for the company, this option will not be 
available. 

Note:  You cannot create a test company for the Demonstration Company. 

The new test company is given the name of the original company, prefixed with 
A test company has all of the data and configuration of the original company. 

You can refresh the data from the original company by selecting the Refresh Test 
Company option from the file menu. This will load the latest data from the original 
company into the test company, overwriting any changes you have made.  
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Note:  When creating or refreshing test companies, if any database files are locked 
or inaccessible, a file called TestCompanyCreation_Log_<datetime>.txt will 
be created in the install directory. This file will contain details of the 
inaccessible files. 

Test Company Restrictions 

The following functions are not available to test companies: 

  of any 
module. 

 You cannot restore a backup to a test company. 

 You cannot generate a direct credit file. 

 You cannot access the MyStaffInfo Management Console. 

You can, however, generate all reports, including IRD reports (functionality that is not 
available in the Demonstration Company). 

Days/Hours Paid History Excel Export 

If Microsoft Excel is installed on your PC, then on the Edit Days/Hours Paid History and 
Edit Relevant Days/Hours Paid History windows, the Copy button is replaced with an 
Excel button. Clicking this button exports the data on the window to a Microsoft Excel 
file in the .XLSX format. 
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Archiving Companies 

This release adds the ability to archive companies. Archived companies are read-only 
for all users, but do not count towards your licensing limits. To archive a company, log 
in to a company and select the Archive Company option from the File menu of Exo 
Payroll: 

 

Archived companies can be restored by selecting the Unarchive Company menu 
option. (Access to these new options is controlled by the User Security settings.) 

Changes to the Login Screen 

The login screen has been updated for the addition of test companies and the ability 
to archive companies. By default, test companies and archived companies are hidden 
on the login screen. If any test or archived companies exist, a new Display dropdown 
is available, which you can use to filter the list of companies: 

 

The login screen has also been widened to include a new column that shows the 
status of each company. 
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Average Weekly Earnings Calculation 

In recent months, a topic has arisen primarily centred on the interpretation of the 
Average Weekly Earnings calculation provided by the Holidays Act, and its use in 
determining the precise average that the Act was intending. In its simplest form, the 
defined calculation from the Act would not provide employers with an accurate 
average; because of this, several variants of the defined calculation have had to be 
implemented across the market to ascertain average earnings. 

Historically, Exo Payroll calculated Average Weekly Earnings based on the total gross 
payments for the previous 12 months and divided this amount by the number of pays 
transacted within this period. Based on much feedback, many employers felt that 12 
months easily translated to 52 weeks, and as such, focusing gross payments for this 
period, and then dividing by the legislated 52, is easier to understand and explain to 
employees.   

With this in mind, Exo Payroll has been altered to reflect the Average Weekly Earnings 
calculation as the total gross payments for the past 52 weeks divided by 52. 

New Installer Screen 

A new screen allowing you to specify the version of Exo Business you are using (if any) 
has been added to the Exo Employer Services install wizard: 

 

Your selection here specifies which version of the ExoOEMLib.dll file will be installed; 
this DLL is used by the Post to Exo Business function in Exo Payroll, so it is important 
that the correct version is installed. 



New Features 

Exo Employer Services 2017.01 Release Notes Page 16 of 27 
Copyright 2017 MYOB Technology Pty Ltd. 

Note:  This option is not available when upgrading online. If you upgrade Exo 
Employer Services using the Upgrade Software Online function, the 
ExoOEMLib.dll file will not be affected, i.e. whatever version of the DLL is 
currently in use will remain in use. If you need to change the version of the 
DLL, e.g. if you upgrade to a newer version of Exo Business, you will need to 
run the installer executable see the MYOB Enterprise Knowledgebase for 
information on upgrading manually. 

Search on Lookup Windows 

The lookup windows for all records in the Maintenance menu now include a search 
box, which allows you to locate records quickly in companies that have a large number 
of records. The Cost Centre lookup window also includes new columns that show the 
General Ledger codes assigned to each Cost Centre. 

    

  

http://myobexo.custhelp.com/app/answers/detail/a_id/32776
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Link to IRD Forms 

A new IRD Forms option has been added to the Help menu in Exo Payroll. Clicking this 
link opens a web page that contains links to commonly used IRD forms, as well as 
information about each form. 

 

Improvements to Employee Training 

When assigning training to employee records in Exo Employee Information, it is now 
possible to add a new training course to assign to the employee. The Add Training 
window now includes an Add button: 
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Registration Updates 

This release includes updates to the user interface that make the process of registering 
products easier to understand. The registration messages that appear in the title bar 
have been re-written to make them clearer, and a How To Register  FAQ link has 
been added to the Registration window: 

 

Clicking this link opens a web browser and links to an article on the Exo Knowledge 
Base that contains more information on registering Exo Employer Services products. 

Clarification of Entitlement Period 

To remove confusion around the definition of the entitlement period for Holiday Pay, 
the date range of the current entitlement period is now displayed on various windows 
concerned with Holiday Pay, e.g. the Leave Management Setup window and the 
Holiday Pay tab of the Employee Maintenance window. 

 

http://myobexo.custhelp.com/app/answers/detail/a_id/37307/kw/37307
http://myobexo.custhelp.com/app/answers/detail/a_id/37307/kw/37307
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New Allowance Option 

A new Exclude from Ordinary Earnings option is available for Allowances: 

 

The calculation of an employee s Ordinary Earnings in relation to the Holidays Act can 
be earnings. A large allowance that is paid infrequently, 
e.g. a Christmas bonus, can distort this calculation by enabling this option for such 
allowances, you can ensur Ordinary Earnings are more representative of 
their true earnings. 

An Ordinary Earnings column has been added to the Edit Hours/Days Paid History 
window, allowing you to verify how Ordinary Earnings have been calculated. 
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Future-Dated Public Holidays 

This release adds the ability to add future-dated Public Hol
pay, i.e. leave that is paid in one pay, but not actually taken until a later pay period. 
Leave paid in this way is added to the employee's pay as an Allowance and taxed as 
Extra Pay. 

A PH  upgrading to this release. This 
Allowance is used to pay future-dated leave; its Type 
will be taxed as Extra Pay. 

A new Future-Dated Public Holiday section has been added to the Public Holiday 
section of the Leave Management window: 

 

To add future-  pay, enter values into the 
Future-Dated Public Holiday section. The Amount is calculated automatically, but can 
be overridden if necessary. 

Future-  
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Rebranding 

The MYOB Exo Employer Services suite of products has been rebranded with an all 
new look and feel: 

 

This rebranding includes graphical updates to the interface and documentation, and a 
new product icon: 
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Resolved Issues 
The following issues have been addressed in this release: 

Problem Record Service Request Description 

11898621227 11897201069 This release adds the ability to print the Pay Sheet report by Physical Pay Date see page 11. 

132944256802 132883017401 132862839611 The Post to Exo Business function did not work when using recent versions of Exo Employer Services with 
older versions of Exo Business. This has been resolved; the Exo Employer Services installer now lets the 
user specify which version of Exo Business is in use, and installs the appropriate DLL see page 15. 

137014170610 137879139709 137666605974 
137601563213 137601436051 
137319257743 137272734634 
137266136496 137264870323 
137252238715 137240291997 
137232496590 137230245131 
137229336366 137195131699 
137190613558 137155576670 
137107521064 137106232509 
137106232332 137105322516 
137092854529 137087901362 
137084224006 137079666366 
137079302985 137073423487 
137068378870 137068378391 
137065847446 137054887698 
137042669165 137038807314 
137015377689 137015377264 
137015377224 137015377184 
137015377174 137015377087 
137014170670 137014170639 
137014170628 137014170571 

When attempting to produce PDFs from Exo Employer Services, t OLE error code 
0x8007007e: The specified module could not be found.
upgraded to Windows 10. This has been resolved; this release includes an updated version of the MYOB 
PDF Converter, which is compatible with Windows 10.  

Note:  Installing Exo Employer Services locally will update the MYOB PDF Converter on the 
local PC you must run Network.exe to reinstall the MYOB PDF Converter on all 
networked PCs. 
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130420454403 140264938217 138671307178 
138655917909 138654767641 
138240804950 138240747027 
137237366186 137137785640 
137125165886 136690416384 
135660968285 134527400379 
134452301554 134444269348 
133565882660 133563807734 
131880295945 130600141761 
130416456969 130352840560 
130341340319 130149850730 
130105346167 129304432943 

Reg
Services, if the details in the Company Contact Details section of the Registration window were blank. This 
has been resolved. 

113279349057 125639079018 122596898289 
119895384386 118512222964 
118290431305 117225521496 
116990601270 114791928821 
113138755669 111885843043 
110155506457 19927754787 
16656645581 16471206102 
15531812100 14558839521 
12534159056 12419633451 

In older versions, it was possible for a Casual employee to have a Holiday Pay cash-up amount, which 
could not then be deleted from the Holiday Pay section of the Current Pay, as the Cash-Up field would be 
disabled. The 2016.01 release made it possible to edit the Cash-Up field in the Holiday Pay section of the 
Current Pay, so that the incorrect amount could be manually deleted. 

cash-up amounts will no 
longer appear for Casual employees, removing the need to manually correct the error. 

124808345008 130315513879 124931637326 
124876428063 124840128254 
124804483817 124689674765 

Large negative wage hourly rate amounts could be incorrectly rounded due to limits on the database field 
used to store them, e.g. -999.99 would round to 999.90. This has been resolved; the relevant database 
field has been enlarged to allow for values of this length. 

124843231466 135535042271 125383530911 
124884559251 124811790611 
124500274523 123094359111 

In some circumstances, 
employee with a different frequency to that employee using the Next or Prev buttons on the Wages 
section of the Standard Pay in frequency would not be 
changed on the Employee Maintenance window, but the wrong pay frequency would be recorded in any 
open pays that the employee was in, which could result in incorrect PAYE being calculated for the 
employee. This has been resolved. 

126825666930 136676193462 132778141151 
126804907239 

The Trial Balance report incorrectly rounded large amounts (over $999,999.99). This has been resolved. 
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138140275096 138140275078 137751188641 This release removes the Tax Holiday Pay options from the Holiday Pay section of the Leave Management 
 

134900362637 134839826462 Leave notes were included on the Custom Payslip. This has been resolved; leave notes no longer appear 
on payslips. 

123269779447 123232580651 This release adds the option to reduce salary when importing leave transactions via the Import Time 
Transactions function. A new Reduce salary when importing leave transactions dropdown is available on 
the Import tab of the Special Options Setup window; this dropdown functions in the same way as the 

salary, never reduce salary or prompt the user whether or not to reduce salary. 

131002509077 130891556374 When the Direct Credit Schedule report was printed in portrait orientation, the Amount Variance total 
would be displayed as *****.** if the value was greater than $9,999.99. This has been resolved. 

133030699800 132992167968 When paying rated unit Allowances to employees, the Custom Payslip did not show the rate. This has 
been resolved. 

135728255239 135728055366 Removing the Exo Payroll module from the Registration window caused errors when attempting to log in 
to other modules. This has been resolved. 

137452073353  137449595748 In some circumstances, Allowances and Deductions could be still deleted even if they had been used in 
the Exo Payroll system. This has been resolved. 

137389317224 137389317012 When creating a non-taxable Allowance, the Add Gross to KiwiSaver option was enabled by default, 
where it had been disabled in previous version. This has been resolved; the default for non-taxable 
Allowances is for this option to be disabled. 

139048431134 138357246713 
resolved. 

131008755385 129934340071 After running the Public Holiday Loader for a Current Pay, if the user opened the Paysheet report, the 
public holiday rates would be incorrect. The rates would be corrected when the Current Pay screen was 
refreshed. This has been resolved. 

140218779973 140218371778 Overridden leave rates were not displayed on the Custom Payslip. This has been resolved. 
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135677276928 135661843841 imes 
window, additional breaks could be created incorrectly. This has been resolved; it is no longer possible to 
change the Cost Centre field when editing a time using the fields at the bottom of the window. To change 

Costcentre column at the top of the window: 

 

140218779973 140218371778 
a pay, 

did not update their average daily/hourly rate(s) until the employee saved and exited the Current Pay 
window. This has been resolved. 

- 136486060416 When processing multiple terminations of percentage-based  
outstanding leave amounts could be incorrect. This has been resolved. 
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- - If the Holiday Pay Loader was used to load holiday pay for an employee in an open Current Pay, who did 
Pay gross pay and 

termination amount would be incorrect. The workaround for this issue was to open and close the Current 
Pay, so that amounts were recalculated. This issue has now been resolved. 

- - The Post to Exo Business function did not work on Windows 10. This has been resolved. 

- - The Custom Payslip would display incorrect values in the Rate column for pay items that had a fixed dollar 
amount. This has been resolved; the Rate column is now left empty for fixed dollar amount items. 

- - The system no longer suggests the first available ID number when creating a new Cost Centre. 

- - Birthday and review reminders were still displayed for terminated employees. This is no longer the case. 

- - In some cases, it was possible to delete a Cost Centre, even if it had been used in a pay. This has been 
resolved. 



 

Exo Employer Services 2017.01 Release Notes Page 27 of 27 
Copyright 2017 MYOB Technology Pty Ltd. 

Known Issues 

Error 2066 in a networked environment 

The FoxPro error: 2066/Index file [filename].CDX is corrupt. Please rebuild it  can 
occur persistently on network systems that have a Server 2008 operating system with 
workstations running Windows Vista, Windows 7 or 2008 Terminal Server; or peer-to-
peer networks where the server/workstation is running a Windows Vista or Windows 7 
operating system, and one or more other workstations are also using a Windows Vista 
or Windows 7 operating system. 

For information on this issue and suggested workarounds, see the following articles on 
the MYOB Enterprise Knowledgebase: 

 What to do when getting an Error 2066 message 

 Consistent error 2066 in a networked environment 

 

http://myobexo.custhelp.com/app/answers/detail/a_id/33878/kw/2066
http://myobexo.custhelp.com/app/answers/detail/a_id/35123/kw/2066/
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